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DEPARTMENT OF MECHANICAL ENGINEERING 
 

VISION 

To be a reputed centre of excellence in the field of mechanical engineering by 

synergizing innovative technologies and research for the progress of society. 

MISSION 

 To impart quality education by means of state-of-the-art infrastructure. 

 To involve in trainings and activities on leadership qualities and social 

responsibilities. 

 To inculcate the habit of life-long learning, practice professional ethics and 

service the society. 

 To establish industry- institute interaction for stake holder development. 



DEPARTMENT OF MECHANICAL ENGINEERING 
 

After 3-5 years of graduation, the graduates will be able to: 

PEO1: Excel as engineers with technical skills, and work with complex 

engineering systems. 

PEO2: Capable to be entrepreneurs, work on global issues, and contribute to 

industry and society through service activities and/or professional 
organizations. 

PEO3: Lead and engage diverse teams with effective communication and 

managerial skills. 

PEO4: Develop commitment to pursue life-long learning in the chosen 

profession and/or progress towards an advanced degree 



DEPARTMENT OF MECHANICAL ENGINEERING 
 

PROGRAM OUTCOMES 
Engineering Graduates will be able to: 

Po1. Engineering knowledge: Apply the basic knowledge of mathematics, science 

and engineering fund a mentals along with the specialized knowledge of mechanical 
engineering to understand complex engineering problems. 

PO2. Problem analysis: Identify, formulate, design and analyse complex 

mechanical engineering problems using knowledge of science and engineering. 

Po3. Design/development of solutions:  Develop solutions for complex 

engineering problems, design and develop system components or processes that 
meet the specified needs with appropriate consideration of the public health and 
safety, and the cultural, societal, and environmental considerations. 

PO4. Conduct investigations of complex problems: Formulate engineering 

problems, conduct investigations and solve using research-based knowledge. 

PO5. Modern tool usage: Use the modern engineering skills, techniques and tools 

that include IT tools necessary for mechanical engineering practice. 

Po6. The engineer and society: Apply the contextual knowledge to assess societal, 

health, safety, legal and cultural issues and the consequent responsibilities relevant to 
the professional engineering practice. 

PO7. Environment and sustainability: Understand the impact of the professional 

engineering solutions in societal and environmental contexts, and demonstrate the 
knowledge of, and need for sustainable development. 

PO8. Ethics: Apply ethical principles and commit to professional ethics and 

responsibilities during professional practice. 

PO9. Individual and team work: Function effectively as an individual, and as a 

member or leader in diverse teams, and in multidisciplinary settings. 

PO10.Communication: Communicate effectively on complex engineering activities 

to various groups, ability to write effective reports and make effective presentations. 

PO11. Project management and finance: Demonstrate and apply the knowledge 

to understand the management principles and financial aspects in multidisciplinary 
environments. 

PO12. Life-long learning: Recognize the need for, and have the preparation and 

ability to engage in Independent and life-long learning in the broadest context of 
technological change. 

PROGRAM SPECIFIC OUTCOMES 

Mechanical Engineering Graduates will be able to: 

PSO1: Apply the knowledge of CAD/CAM/CAE tools to analyse, design and develop 

the products and processes related to Mechanical Engineering. 

PSO 2: Solve problems related to mechanical systems by applying the principles of 

modern manufacturing technologies. 

PSO 3: Exhibit the knowledge and skill relevant to HVAC and IC Engines. 



CODE OF CONDUCT 

1. Students should report to the concerned labs as per the time table schedule. 

2. Students who turn up late to the labs will in no case be permitted to perform the 
experiment scheduled for the day. 

3.  After completion of the experiment, certification of the concerned staff in-charge 
in the observation book is necessary. 

4. Staff member in-charge shall award marks based on continuous evaluation for each 
experiment out of maximum 15 marks and should be entered in the evaluation 
sheet/attendance register. 

5. Students should bring a note book of about 100 pages and should enter the 
readings/observations into the note book while performing the experiment. 

6. The record of observations along with the detailed experimental procedure of the 
experiment performed in the immediate last session should be submitted and certified by 
the staff member in-charge. 

7. Not more than three students in a group are permitted to perform the experiment on a 
setup for conventional labs and one student in case of computer labs. 

8. The components required pertaining to the experiment should be collected from stores 
in-charge after duly filling in the requisition form. 

9. When the experiment is completed, students should disconnect the setup made by them, 
and should return all the components/instruments taken for the purpose. 

10. Any damage of the equipment or burn-out of components will be viewed seriously either 
by putting penalty or by dismissing the total group of students from the lab for the 
semester/year. 

11. Students should be present in the labs for the total scheduled duration. 

12. Students are required to prepare thoroughly to perform the experiment before coming to 
Laboratory. 



DO’S 

1. Leave footwear & bag outside the laboratory at their designated place. 

2. Enter the system number in the register & use the system alone. 

3. Report any broken plugs, exposed electrical wires or any unsafe conditions to your 
lecturer/laboratory staff immediately. 

4 . 
ReadandunderstandtheprocedurefromLabManualashowtocarryoutanactivitythoroughl   
y before coming to the laboratory. 

5. Always keep anti-virus in active mode 

6. Students must carry their Identity Cards & Observation Notes in the Lab. 

7. Enter or Leave the lab only with the permission of the lab in charge. 

8. Turn off the respective system and arrange the chairs properly before leaving the 
laboratory. 

 

 
DON'TS 

1. Do not install, uninstall or alter any software on computer. 

2. Do not touch electrical fittings nor connect or disconnect any plug or cable. 

3. Do not plug in external drives like pen drive, external hard disk or mobile phone 

4. Students are not allowed to work in the Lab without the presence of faculty or instructor. 

5. Do not leave your place, misbehave or make noise while in the Lab. 

6. Don’t scatter around unwanted things while doing an experiment. 

7. Do not eat or drink in the laboratory. 



COURSE OBJECTIVES 

The objective of this course is 
 

1. To introduce fundamentals of the analysis software, its features and applications.  

2. To learn the basic element types in Finite Element analysis. 

3. To know the concept of discretization of continuum, Loading conditions and analyse the 
structure using pre-processor and postprocessor conditions. 

 

 
COURSE OUTCOMES 

 

CO 
No. 

Course Outcomes PO 

CO 1 Classify different types of truss and perform static analysis 
1,2,3,5,8,9,10,12 

CO 2 Classify different  types of meshing  
1,2,5,8,9,10,12 

CO 3 
Analyze stress and deformation  in case of axi-symmetric loading 

. 

1,2,3,5,8,9,10,12 

CO 4 Perform static analysis on connecting rod with 3D elements 
1,2,3,5,8,9,10,12 

CO 5 Predict natural frequencies in case of critical loading condition. 
1,2,3,5,8,9,10,12 

CO 6 
Simulate coupled analysis using static structural and steady state 

thermal 

1,2,3,5,8,9,10,12 

 
COURSE OUTCOMES VS POs MAPPING 

 

SNO PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PO11 PO12 PSO1 PSO2 PSO3 

PC692ME.1 

PC692ME.2 

PC692ME.3 

3.0 

3.0 

3.0 

3.0 

3.0 

3.0 

3.0 

- 

3.0 

3.0 

3.0 

3.0 

1.0 

1.0 

1.0 

- 

- 

- 

- 

- 

- 

1.0 

1.0 

1.0 

1.0 

1.0 

1.0 

1.0 

1.0 

1.0 

- 

- 

- 

1.0 

1.0 

1.0 

3.0 

3.0 

3.0 

- 

- 

- 

- 

- 

- 

PC692ME.4 3.0 3.0 3.0 3.0 1.0 - - 1.0 1.0 1.0 - 1.0 3.0 - - 

PC692ME.5 3.0 3.0 3.0 3.0 1.0 - - 1.0 1.0 1.0 - 1.0 3.0 - - 

PC692ME.6 3.0 3.0 3.0 3.0 1.0 - - 1.0 1.0 1.0 - 1.0 3.0 - - 

Avg 3.0 3.0 3.0 3.0 1.0 - - 1.0 1.0 1.0 - 1.0 3.0 - - 
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Introduction to Ansys 
 

Description: 
 

The ANSYS Workbench environment is an intuitive up-front finite element analysis tool that 

is used in conjunction with CAD systems and/or Design Modeler. ANSYS Workbench is a 

software environment for performing structural, thermal, and electromagnetic analyses. The 

class focuses on geometry creation and optimization, attaching existing geometry, setting up 

the finite element model, solving, and reviewing results. The class will describe how to use 

the code as well as basic finite element simulation concepts and results interpretation. 

 
Steps in Ansys Workbench: 

 
 Workbench GUI 

 Engineering Data 

 Design Modeler 

 Geometry 

 Model 

 Meshing 

 Setup 

 Solution 

 Result 

 
 

Workbench GUI 

Introduction This document serves as a step-by-step guide for conducting a Finite Element 

Analysis (FEA) using ANSYS Workbench. It will cover the use of the simulation package 

through the graphical user interface (GUI). More advanced topics will also be briefly covered. 

 

Aims and Objectives 

The purpose of this document is to provide step-by-step instructions on how to use ANSYS 

Workbench through the GUI. Upon completion, the student should be able to: 

• use symmetry conditions to simplify a typical engineering problem 

• perform a finite element simulation of a typical engineering problem 

• investigate the effects of certain variables that are changed 

 
 

Launch Ansys Workbench: 

Launching ANSYS Workbench the ANSYS installation has many packages included. For this 

tutorial, we will be using ANSYS Workbench. 



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 2 

 

 

Engineering Data: 

 

A part’s response is determined by the material properties assigned to the part. 

 

 Depending on the application, material properties can be linear or nonlinear, as 

well as temperature-dependent. 

 Linear material properties can be constant or temperature - dependent, and 

isotropic or orthotropic. 

 Non linear material properties are usually tabular data, such as plasticity data 

(stress-strain curves for different hardening laws), hyper elastic material data. 

 To define temperature - dependent material properties, you must input data to 

define a property - versus - temperature graph. 

 Although you can define material properties separately for each analysis, you 

have the option of adding your materials to a material library by using the 

Engineering Data tab. This enables quick access to and re-use of material data 

in multiple analyses. 

 For all orthotropic material properties, by default, the Global Coordinate System 

is used when you apply properties to apart in the Mechanical application. If 

desired, you can also apply a local coordinate system to the part. 

 

To manage materials, right-click on the Engineering Data cell in the analysis system 

schematic and choose Edit. 

 

Geometry: 

 

All analysis systems and several component systems, including Geometry, Meshing, and 

Mechanical Model, begin with a geometry-definition step. You can define the geometry 

differently depending on the type of simulation you are running. In most cases, you will use 

the Geometry cell. Via the Geometry cell, you can: 

 

 Create a geometry from scratch in Design Modeler 

 Import an existing geometry: 

 From neutral formats like IGES, STEP, Para solid, ACIS 

 From CAD files on disk 

 From an active CAD session that is already running on 

the same machine 

 

For Fluid Flow simulations, you can also start with an imported mesh or case file; see Basic 

Fluid Flow Analysis, Starting from an Imported Mesh for details. 

 

Specifying Geometry via the Context Menu 

 

1. Right-click the Geometry cell. 

2. Choose New Geometry to launch Design Modeler and create a 

new model, or choose Import Geometry and browse to an existing 

CAD model. 

https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_sim/ds_Global_Coordinate_System_o_r.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_sim/ds_coordinate_systems_toolbar.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/ref_cad/cadIGES.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/ref_cad/cadIGES.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/ref_cad/cadParasolid.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/ref_cad/cadACIS.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb2_help/wb2h_ffworkflow.html#wb2h_basicffmeshstart
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb2_help/wb2h_ffworkflow.html#wb2h_basicffmeshstart
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Alternatively, you can also launch ANSYS Workbench directly from some CAD systems. 

When doing so, ANSYS Workbench starts with a Geometry system in place and the CAD file 

already attached. 

 

After you have attached or imported your geometry, the state appears as Up to Date, and the 

icon indicates the type of file imported. 

 

If you do not need to make any additional changes to your geometry, you can continue 

working through the analysis as described in the next sections. 

 

If your geometry needs to be modified before continuing with your analysis, you can edit the 

geometry in Design Modeler. After modifying the geometry in Design Modeler or importing a 

Design Modeler file, the icon in the Geometry cell will change to a Design Modeler icon. For 

a file imported and then modified in Design Modeler, you can open the file in Design 

Modeler, and the Design Modeler model tree will indicate the original source of geometry. 

 

After the geometry is defined, you can share it with other systems. See Data Sharing and Data 

Transfer for more information on sharing geometry systems. 

 
Model / Mesh: 

 

ANSYS Twin Builder is a powerful platform for modelling, simulating and analysing virtual 

systems prototypes. It enables product development teams to verify and optimize performance 

of their software-controlled, multi domain systems designs. 

 

The Model cell in the Mechanical application analysis systems or the Mechanical Model 

component system is associated with the Model branch in the Mechanical application and 

affects the definition of the geometry, coordinate systems, connections and mesh branches of 

the model definition. 

 

When linking two systems, you cannot create a share between the Model cells of two 

established systems. You can generate a second system that is linked at the Model cell of the 

first system, but you cannot add a share after the second system has been created. Likewise, 

you cannot delete a link between the Model cells of two systems. 

 

The Mesh cell in Fluid Flow analysis systems or the Mesh component system is used to create 

a mesh using the Meshing application. It can also be used to import an existing mesh file. 

 

Edit 

 

Launches the appropriate Model or Mesh application (the Mechanical 

application, Meshing, and so on.) 

 
Setup: 

 

Use the Setup cell to launch the appropriate application for that system. You will define your 

loads, boundary conditions, and otherwise configure your analysis in the application. The data 

from the application will then be incorporated in the project in ANSYS Workbench, including 

connections between systems. 

https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb2_help/wb2h_understandingstates.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_dm/ProjSchemDataShare.html
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_dm/ProjSchemDataShare.html
https://www.sharcnet.ca/Software/Ansys/17.0/en-us/help/wb2_help/wb2h_Meshapp.html
https://www.sharcnet.ca/Software/Ansys/17.0/en-us/help/wb_msh/msh_book_wb.html


Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 4 

 

 

For the Mechanical application systems, you will see the following Setup options, in addition 

to the common options: 

 

Edit 

 
Launches the Mechanical application with the geometry loaded and with cells mapped 

to their respective tree locations in the Mechanical application. 

For CFX systems, you will see the following Setup options, in addition to the common options: 

 

Edit 

 
Launches CFX-Pre. 

 

Import Case 

 
Imports an existing case file containing physics data, region and mesh information for 

your analysis. 

 

For Fluent systems, you will see the following Setup options, in addition to the common 

options: 

 

Edit 

 
Launches ANSYS Fluent. 

 

Import Case 

 
Imports an existing Fluent case file. 

 
Solution: 

 

From the Solution cell, you can access the Solution branch of your application, and you can 

share solution data with other downstream systems (for instance, you can specify the solution 

from one analysis as input conditions to another analysis). If you have an analysis running as 

a remote process, you will see the Solution cell in a pending state until the remote process 

completes. See the discussion on Understanding Cell States, below. 

For the Mechanical application systems, you will see the following Setup options, in addition 

to the common options described earlier: 

 

Edit 

 
Launches the Mechanical application open to the Solution branch. 

 

Delete 

 
Deletes the Solution and Results cell. Deleting the solution cell makes the system a 

setup-only system, meaning the system will generate only an input file. It will not 

solve 

https://www.sharcnet.ca/Software/Ansys/17.0/en-us/help/wb2_help/wb2h_understandingstates.html
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or post results. The Solution object and below are removed from the 

Mechanical application tree. 

 

For CFX systems, you will see the following Solution options, in addition to 

the common options: 

 

Edit 

 
Launches CFX-Solver Manager. 

 

Import Solution 

 
Displays the most recent CFX-Solver Results files imported (if any) 

and enables you to browse for such files using the Open dialog box, 

where you can specify the CFX- Solver Results file to load. When 

the results file is loaded, the system will display only the Solution 

cell and the Results cell. 

 

Display Monitors 

 
Opens the ANSYS CFX-Solver Manager and shows the results of the previous 

run. 

 

For Fluent systems, you will see the following Solution options, in addition 

to the common options: 

 

Edit 

 
Launches ANSYS Fluent. 

 

Import Final Data 

 
Enables you to select an existing Fluent data set (for example, one 

solved on an external cluster) into a Solution cell in a Fluent system 

and immediately start post-processing in CFD-Post, without the need 

to run the minimum of one more solver iteration. This option 

becomes available after importing case file into the Setup cell. 

 
Results: 

 

The Results cell indicates the availability and status of the analys is results 

(commonly referred to as post processing). From the Results cell, you cannot 

share data with any other system. 
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EXPERIMENT - 01 
 

3D BEAM ANALYSIS WITH DIFFERENT CROSS SECTIONS, SAME  

MATERIALS FOR SAME LOADS 
 

AIM: 
To Determine the Total Deflection and Von Misses Stress of various 3 Dimensional 

Beam. 
 

SOFTWARE: ANSYS 

 

THEORY: 
Consider For different Section as Shown in Figure having Young’s Modulus Of Elasticity of 

2000000  𝑁 𝑚𝑚2⁄  

Calculate and Compare the deflection and Von Mess Stress. 
 

 

 

PROCEDURE: 
Step I  

Create Geometry –Open Ansys Workbench –Static Structural 



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 7 

 

 

Create  Select Rectangle  Option Create Geometry 
 

 
 

Trim Geometry 
 

 
  

Select Pull Option Extrude 100 mm 
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Step 2 -Updating Material Properties  
 

Right Click Update Geometry-Update Model – By Default Ansys will Provide Steel 

Property   

 
 

Step 3 -Creating Mesh 

 
 

Step 4 -Creating Boundary Condition   

 Select at least one corner  Faces And Apply Fix Support  
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Select  An Edge  and apply load of 100 N in Z direction 

 
 

 

Step 5 -Solution -Total Deformation -Von Misses stress 
 

 Total Deformation  

 Equivalent Stress 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Differentiate Between Beam vs Bar ? 

 What is the physical Significance of Young’s modulus of Elasticity ? 

 What is the full form of ANSYS? 

 What are the basic steps for Analysis ? 

 Differentiate between  Meshing and Nodes ? 

 What do you mean by Boundary Conditions? 

 Define Factor of Safety ? 

 How can you validate your design using F.E.A Results ? 

 Define Modulus of Rigidity ? 

 Solid vs Hollow Shaft which has more load bearing capacity ? 
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EXPERIMENT - 02 
 

1D, 2D AND 3D MESHING OF CANTILEVER BEAM 

AIM: 
1D, 2D and 3D meshing with different element sizes for different CAD geometry 
 

SOFTWARE:  ANSYS 

 

THEORY: 
Calculate 1D, 2D and 3D  Mesh For The Given Below Geometry  

1D Mesh  

 
2D Mesh 

 
 

 



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 13 

 

 

 

3D Mesh 

 
 

PROCEDURE: 
Step 1  1D  meshing  
Click Static Structural Geometry  
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Dimensional  Cantilever Beam Geometry 
 

 
 

 

Creating Rectangular Beam Profile 

 

 
Reducing Rectangular Profile 
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Connect Line to beam 

 

 
 

 

 

 

 

Step 2 :-  Giving Material Properties -Right Click Materials -Right- Click - Model. 

 
 

Step 3 :-  Creating Mesh - Click Mesh - 1 Dimensional Meshing is done. 

 

Step 2  2D  meshing  

Click on static structural  
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Right Click Update Geometry 
 

 

 

3D Mesh 
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Create Geometry 

 
 

3D Geometry 
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3D Mesh 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Differentiate between , 1D, 2D , 3D Meshing  ? 

 Define Nodes ? 

 Define Convergence ? 

 What are the various quality Creations for meshing ? 

 Is it possible to solve a problem without meshing ? 

 Enumerate geometry Clean up ? 

 Define Auto mesh ? 

 Geometry clean-up, Mid-Surface ? 

 When to use 3-D Elements, DOFs for Solid Elements, Quality Checks for 3-D 

Elements ? 

 How to do Meshing Without Surface 
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1 

2 
3 

4 

EXPERIMENT - 03 
 

ANALYSIS OF 2D TRUSSES 
AIM: 

Analysis of Plane Truss to determine member forces, stresses,  deflections under static 

loading. 

 

SOFTWARE: ANSYS 

 

THEORY: 
Consider the four-bar truss shown in figure. For the given data, find Stress in each 

element, Reaction forces, Nodal displacement. E = 210 GPa, A = 0.1 m2. 
 

PROCEDURE: 
Step 1: Workbench Toolbox 

Toolbox - Analysis Systems - Static Structural 

Open Static Structural dialog box will appear 

In that Engineering Data open by default Structural Steel will be there  

Close Engineering Data and from dialog box open Geometry 
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Step 2: Create A Geometry 
From dialog box open Geometry 

  

Select XY Plane and make it Look at Face 

Set Units as Meter 
 

Sketching - Draw – Line 

Draw the line on X axis by using Line tool bar complete the diagram 

Sketching - Dimensions - Horizontal 4m 

Vertical 3m 
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Go to Concept - Cross Section - Circular – R0.0364 
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Go to Concept – Lines From Sketches 
 

 

A: Static Structural – XY Plane – Sketch1 – Apply 
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Line1 – Generate – 1 Part 1 Body – Line Body – Cross Section – Circular 1 
 

 

Step 3: Model 
From dialog box Select 

Model Model – Update 
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Open Model 

Geometry – Line Body – Assignment – Structural Steel 
 

 

Mesh – Generate Mesh 
 

 

Select Vertex – First Point – Static Structural – Insert – Fixed Support 

Second Point – Static Structural – Insert – Fixed Support 
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Third Point – Static Structural – Insert – Fixed Rotation 
 

 

Fourth Point – Static Structural – Insert – Force 

Components – Y Component – (- 

2500 N) -ve sign is for down ward direction 

Third Point – Static Structural – Insert – Force 

Components – X Component – ( 

2000 N) 
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Solution – Insert – Deformation – Total – Solve 
 

 

Solution – Insert – Coordinate Systems – Elemental Triads – Solve 
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Solution – Insert – Coordinate Systems – Nodal Triads – Solve 
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RESULT& CONCLUSIONS: 
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VIVA QUESTIONS: 

 What  do you mean  truss? 

 Define Meshing ? 

 Differentiate Beam Vs Bar? 

 What is F.E.A ? 

 Explain the process of F.E.A 
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EXPERIMENT - 04 
 

STATIC ANALYSIS OF PLATES WITH A HOLE 
 

AIM: 
Static Analysis of plates with a hole to determine the deformation and Equivalent Stress. 

 

SOFTWARE:  ANSYS 

 

THEORY: 
The objective of this experiment is to demonstrate  the basic ANSYS Space Claim  

procedure to draw and perform simple analysis This problem is a simple dimensional 

structural problem of a simple bracket as shown in figure .The bracket is made of 10 mm 

thick steel plate .The material properties of steel are given below: 

 Young’s Modulus, E = 200 109 Pascal 

 Poisson’s Ratio, γ      = 0.3 

 Density,  ρ                  = 7860 kg/m3 

 
 
The forces Acting are shown below 
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PROCEDURE: 
Step1: Workbench Tool box 
Toolbox-Analysis Systems-Static Structural  

Click on Static Structural Analysis  

Click on Geometry Space Claim  

Response Dialogue Box Will Appear :- 

 

 
 

 

Step2-Creating Geometry  
Click on geometry Dialogue box Space Claim option will open. 

 

 
 

Select any Plane Using Pan View  
Set Units as mm 
Sketch Two Line perpendicular to each with 100mm dimension each as shown in figure. 
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Draw a circle of 60 mm radius at a distance of 50mm from vertical as shown in figure. 
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Draw another circle with 100 mm diameter as shown in figure. 

 
 

Draw another circle with given dimensions 
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Trim 

 
 

Pull 
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Giving Fillets 

 
 

Deleting Unwanted Geometry and line by selecting Delete icon 
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Click on Model Update it and wait for geometry to upload then double click it 

 
 

 
 

Click on Mesh 
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Boundary Condition :- Fix two small Holes 

 
 

Click on Bigger Circle and Give Force of -1000 pa in –x Direction 
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Insert Deformation and Von Mess Stress 

 
 

 Total Deformation 
 Equivalent Stress 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Define Stress Concentration Factor? 

 What is the difference between surface and solid.? 

 How to provide thickness of surface in  ANSYS Workbench? 

 What type of meshing is used for Surface Modeling ? 

 What type of meshing is used for Solid Modelling ? 

 What are the boundary condition for plate with a hole analysis problem ? 

 Differentiate between Tetrahedron ,Quadrilateral ? 

 Differentiate between structured Grid Vs Unstructured Gird? 

 What do you mean by mesh Quality ? 

 How to decide Type of meshing ? 
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EXPERIMENT - 05 
 

STRESS AND DEFORMATION OF AXI-SYMMETRIC MODEL 
 

AIM: 
To calculate Stress in case of axi-symmetric body. 

 

SOFTWARE:  ANSYS 

 

THEORY: 
A. Create a 2D axi-symmetric model  

B. Create a 3D sold model (1/4 symmetric) 

C. Create a 3D shell (1/4 symmetric) , assume E = 207  
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PROCEDURE: 
Opening Space Claim 

Drawing Geometry 

 
 

Trim 
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Draw rectangle 

 
 

Trim 
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Pull-Revolve 

 
 

Mesh 
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Boundary Condition 

 
 

 

 Total Deformation 

 Equivalent Stress  
 

  



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 49 

 

 

RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Define Axi-symmetric Element? 

 

 What are different types of loading in case of axi-symmetric loading ? 

 

 Differentiate between 2D, 3D Analysis? 

 

 Differentiate between Stress And Pressure ? 

 

 Differentiate between symmetric and Axi-symmetric? 
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EXPERIMENT - 06 
 

STATIC ANALYSIS OF CONNECTING ROD 

AIM: 
To do Static analysis of connecting rod. 

 

SOFTWARE:  ANSYS 

 

THEORY: 
To determine the deformation and Equivalent Stress  in case of connecting Rod 

 

 
 

PROCEDURE: 
Opening Space Claim 

Drawing Geometry 
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Draw Circle  
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Trimming Geometry 

 
 

 

Pull 
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Draw 2D rod 

 
 

Mirror 
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Pull 

 
 

Giving Fillet 
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Update Geometry in Model 

 
 

Mesh 

 
 

Boundary Condition 
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Boundary Condition 

 
 

 Total Deformation 

 Equivalent stress 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Differentiate Between Solid Meshing and Shell Meshing  ? 

 Explain the boundary condition in case of connecting rod ? 

 What are different types of forces acting in connecting rod ?  

 Define factor of safety ? 

 How can FEA be used to optimize the design . 
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EXPERIMENT - 07 
 

STATIC ANALYSIS OF CURVED SHELL DUE TO INTERNAL 

PRESSURE 
 

AIM: 
To find out deformation and equivalent stress of a curved shell due to internal 

pressure. 
 

SOFTWARE:  ANSYS 

 

THEORY: 
From the following given diagram of pipe calculate the internal pressure in the pipe. 

 
 

PROCEDURE: 
Creating Geometry 

Trim Unwanted Lines :- 

Draw Another Rectangle as shown 
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Trim Geometry 
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Create Construction Line 

 
 

 

Revolve Along 
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Right Click Model Update it will automatically Take geometry as Steel 

 
 

Right Click Mesh 

 
 

Select Faces  Insert Fix Support 

 



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 64 

 

 

 

Inserting Pressure in Y Direction of 1000 Pa 

 

 
 

 

 Equivalent Stress  
 Total Deformation   
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RESULT & CONCLUSIONS: 

  



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 66 

 

 

VIVA QUESTIONS: 

 What are different types of stress in  case of Pipe  

 What is the difference between Longitudinal stress and lateral stress ? 

 What type of meshing is used in the analysis of shell element  

 What do you mean by stiffness matrix  

 Define shape function  
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EXPERIMENT - 08 
 

MODAL ANALYSIS OF BEAM TO CALCULATE NATURAL 

FREQUENCY OF BEAM 
 

AIM: 
To determine Natural frequency and modal analysis of beam. 

 

SOFTWARE:  ANSYS 
 

THEORY: 
Determine the Natural Frequency in case of Beam  as shown in figure. 

 
 

PROCEDURE: 
 

Create Geometry 
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Trim Geometry 

 
 

Extrude up to 100mm 
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Update Model – Default Structural Steel 

 
 

Mesh 

 
 

Insert Fix Support 
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Insert Solution 

 
 

Mode Shapes Generated 

 
 

 

Right Click Evaluate All Results 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Define Natural Frequencies ? 

 What is the significance of modal analysis ? 

 What is the Significance of Poisson’s Ratio ? 

 Define Rigid Body ? 

 How To Determine the Element size  in case of analysis  
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EXPERIMENT - 09 
 

STEADY STATE THERMAL ANALYSIS OF CHIMNEY 

 
 

AIM: 
Steady state heat transfer Analysis Cross section of chimney. 

 

SOFTWARE:  ANSYS 

 

THEORY: 
Determine The steady heat transfer analysis in case of chimney 

 
 

PROCEDURE: 
Step -1 Create Geometry 
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Trim Geometry 
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Revolve Pull 

 

 
 

 

Update Mesh 
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Select face Apply Temperature 

 

 
 

 Temperature  
 Heat Flux 

 

 
 

 
 

 

 

  



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 77 

 

 

RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Differentiate between Steady state temperature vs Transient temperature > 

 Define heat Flux ? 

 What is the significance of the coefficient of thermal expansion ? 

 Define heat Conduction ? 

 Define Heat Convection ? 
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EXPERIMENT - 10 

NON-LINEAR ANALYSIS OF CANTILEVER BEAM WITH NON-

LINEAR MATERIAL 
 

AIM: 
To determine deformation in case of cantilever beam with nonlinear material 

 

SOFTWARE:  ANSYS 

 

THEORY: 
From the given dimension below assign non linear material and find out the TOTAL 

DEFORMATION. 

 
 

PROCEDURE: 
Step 1 – Create geometry 
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Trimming Geometry 

 

 
 

Extruding Geometry 100 mm 
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Assigning Material 

 
 

Assign Plasticity non-linear to material model 
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Mesh 

 
 

 

 

Click Face – Insert Fixed Support 
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Apply Force 100 N , X direction 

 

 
 

 

 
 Total Deformation 

 Equivalent Stress 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Differentiate between linear and non linear Material ? 

 Define Yield Point ? 

 Define Ultimate tensile strength? 

 Define Plasticity ? 

 Define Elasticity ? 
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EXPERIMENT - 11 
 

COUPLED FIELD ANALYSIS 

AIM: 

To determine  total deformation and temperature distribution using coupled field 

analysis  

 

SOFTWARE:  ANSYS 
 

THEORY: 
Given below the disc brake  as shown in figure , determine the total deformation and 

temperature Evolved. 

 
 

PROCEDURE: 
Step 1 - Create Geometry 
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Extrude :- 5mm 

 
 

Creating Construction line up to 15mm 

 

 

Creating a hole of 5mm at a distance 15 mm 
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Creating a hole 

 
 

 

Creating Circular Pattern of Hole 
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Updating the model in the geometry 

 

 
 
Double Click Model 

 
 

Mesh 
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Insert Fix Support 

 

 

Select all the hole faces and apply Force 0f 100 N 

 

 

 Total Deformation 

 Equivalent Stress 

Couple Field Analysis 
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Select Body Insert Temperature 

 
 

 Temperature – Total Heat Flux 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 What do you mean by coupled analysis  

 Define the boundary condition in case of disc brake? 

 Differentiate between steady state and transient heat thermal analysis ? 

 What is the coefficient of friction between the brake pad and brake disc ? 

 Which material is used to make disc brake ? 
  



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 94 

 

 

EXPERIMENT - 12 

BUCKLING ANALYSIS OF BEAM 
 

AIM: 
To Study the deflection of a buckling. 

 Eigenvalue buckling analysis 

 

SOFTWARE:  ANSYS 

 

THEORY: 
Buckling loads are critical loads where certain types of structures become unstable. 

Each load has an associated buckled mode shape; this is the shape that the structure assumes 

in a buckled condition. There are two primary means to perform a buckling analysis: 

 Eigenvalue 
Eigenvalue buckling analysis predicts the theoretical buckling strength of an ideal 

elastic structure. It computes the structural eigenvalues for the given system loading 

and constraints. This is known as classical Euler buckling analysis. Buckling loads for 

several configurations are readily available from tabulated solutions. However, in 

real-life, structural imperfections and nonlinearities prevent most real-world structures 

from reaching their eigenvalue predicted buckling strength; i.e. it over-predicts the 

expected buckling loads. This method is not recommended for accurate, real-world 

buckling prediction analysis. 

 
A steel beam with a 10 mm X 10 mm cross section, rigidly constrained at the bottom. The 

required load to cause buckling, applied at the top-center of the beam, will be calculated. 

 

PROCEDURE: 

Eigenvalue Buckling Analysis 

Preprocessing: Defining the Problem 

1. Open preprocessor menu 
/PREP7 
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2. Give example a Title 
Utility Menu > File > Change Title ... 

/title, Eigen-Value Buckling Analysis 

3. Define Keypoints 
Preprocessor > Modeling > Create > Keypoints > In Active CS ... 

K,#,X,Y 

We are going to define 2 Keypoints for this beam as given in the following 

table: 

Keypoints Coordinates (x,y) 

1 (0,0) 

2 (0,100) 

4. Create Lines 
Preprocessor > Modeling > Create > Lines > Lines > In Active Coord 

L,1,2 

Create a line joining Keypoints 1 and 2 

5. Define the Type of Element 
Preprocessor > Element Type > Add/Edit/Delete... 

For this problem we will use the BEAM3 (Beam 2D elastic) element. This 

element has 3 degrees of freedom (translation along the X and Y axes, and 

rotation about the Z axis). 

6. Define Real Constants 
Preprocessor > Real Constants... > Add... 

In the 'Real Constants for BEAM3' window, enter the following geometric 

properties: 

i. Cross-sectional area AREA: 100 

ii. Area moment of inertia IZZ: 833.333 

iii. Total Beam Height HEIGHT: 10 

This defines a beam with a height of 10 mm and a width of 10 mm. 

7. Define Element Material Properties 
Preprocessor > Material Props > Material Models > Structural > Linear > 

Elastic > Isotropic 

In the window that appears, enter the following geometric properties for steel: 

i. Young's modulus EX: 200000 

ii. Poisson's Ratio PRXY: 0.3 

8. Define Mesh Size 
Preprocessor > Meshing > Size Cntrls > Manual Size > Lines > All Lines... 

For this example we will specify an element edge length of 10 mm (10 

element divisions along the line). 

9. Mesh the frame 
Preprocessor > Meshing > Mesh > Lines > click 'Pick All' 

LMESH,ALL 

 

Solution Phase: Assigning Loads and Solving 

1. Define Analysis Type 
Solution > Analysis Type > New Analysis > Static 

ANTYPE,0 

2. Activate prestress effects 
To perform an eigenvalue buckling analysis, prestress effects must be activated. 
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o You must first ensure that you are looking at the unabridged solution menu so 

that you can select Analysis Options in the Analysis Type submenu. The last 

option in the solution menu will either be 'Unabridged menu' (which means 

you are currently looking at the abridged version) or 'Abriged Menu' (which 

means you are looking at the unabridged menu). If you are looking at the 

abridged menu, select the unabridged version. 

o Select Solution > Analysis Type > Analysis Options 

o In the following window, change the [SSTIF][PSTRES] item to 'Prestress 

ON', which ensures the stress stiffness matrix is calculated. This is required in 

eigenvalue buckling analysis. 

 

 
 

3. Apply Constraints 
Solution > Define Loads > Apply > Structural > Displacement > On 

Keypoints 

Fix Keypoint 1 (i.e. all DOF constrained). 

4. Apply Loads 
Solution > Define Loads > Apply > Structural > Force/Moment > On 

Keypoints 

The eignenvalue solver uses a unit force to determine the necessary buckling 

load. Applying a load other than 1 will scale the answer by a factor of the load. 

Apply a vertical (FY) point load of -1 N to the top of the beam (keypoint 2). 

The applied loads and constraints should now appear as shown in the figure below. 
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5. Solve the System 
Solution > Solve > Current LS 

SOLVE 

6. Exit the Solution processor 
Close the solution menu and click FINISH at the bottom of the Main Menu. 

FINISH 

Normally at this point you enter the postprocessing phase. However, with a buckling 

analysis you must re-enter the solution phase and specify the buckling analysis. Be 

sure to close the solution menu and re-enter it or the buckling analysis may not 

function properly. 

7. Define Analysis Type 
Solution > Analysis Type > New Analysis > Eigen Buckling 

ANTYPE,1 

8. Specify Buckling Analysis Options 
o Select Solution > Analysis Type > Analysis Options 

o Complete the window which appears, as shown below. Select 'Block Lanczos' 

as an extraction method and extract 1 mode. The 'Block Lanczos' method is 

used for large symmetric eigenvalue problems and uses the sparse matrix 

solver. The 'Subspace' method could also be used, however it tends to 

converge slower as it is a more robust solver. In more complex analyses the 

Block Lanczos method may not be adequate and the Subspace method would 

have to be used. 
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9. Solve the System 
Solution > Solve > Current LS 

SOLVE 

10. Exit the Solution processor 
Close the solution menu and click FINISH at the bottom of the Main Menu. 

FINISH 

Again it is necessary to exit and re-enter the solution phase. This time, however, is for 

an expansion pass. An expansion pass is necessary if you want to review the buckled 

mode shape(s). 

11. Expand the solution 
o Select Solution > Analysis Type > Expansion Pass... and ensure that it is on. 

You may have to select the 'Unabridged Menu' again to make this option 

visible. 

o Select Solution > Load Step Opts > ExpansionPass > Single Expand > 

Expand Modes ... 
o Complete the following window as shown to expand the first mode 

 

 
12. Solve the System 

Solution > Solve > Current LS 

SOLVE 

 

Postprocessing: Viewing the Results 

1. View the Buckling Load 
To display the minimum load required to buckle the beam select General 

Postproc > List Results > Detailed Summary. The value listed under 

'TIME/FREQ' is the load (41,123), which is in Newtons for this example. If 

more than one mode was selected in the steps above, the corresponding loads 

would be listed here as well. 

/POST1 

SET,LIST 

2. Display the Mode Shape 
o Select General Postproc > Read Results > Last Set to bring up the data for 

the last mode calculated. 

o Select General Postproc > Plot Results > Deformed Shape 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Define Buckling . 

 State the Boundary Condition for buckling . 

 Differentiate Between Linear and non linear buckling . 

 Define Shell Element. 

 Define Solid Element 
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EXPERIMENT - 13 

HARMONIC ANALYSIS OF CANTILEVER BEAM 

AIM: 

To Study the stress and deflection on the Cantilever Beam by using cyclic load 

 

SOFTWARE:  ANSYS 

 

THEORY: 
Conduct a harmonic forced response test by applying a cyclic load (harmonic) 

at the end of the beam. The frequency of the load will be varied from 1- 100 Hz. Modulus of 

elasticity = 200 GPa, Poisson’s ratio = 0.3, Density = 7800 Kg/m3. 

 

PROCEDURE: 
Step 1: Workbench Toolbox 

Toolbox - Analysis Systems – Harmonic Response 

Open Harmonic Response dialog box will appear 
 

 
 

In that Engineering Data open by default Structural Steel will be there 

Close Engineering Data and from dialog box open Geometry 



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 102 

 

 

Step 2: Create A Geometry 

From dialog box open Geometry 
 

 

Select XY Plane - Sketch and make it Look at Face 

Set Units as Meter 
 

Sketching - Draw – Rectangle 

Sketching - Dimensions - Horizontal 0.1m 

Vertical 0.1m 
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Extrude – Apply – 1m – Generate 
 

 

Step 3: Model 

From dialog box Select Model 

Model – Update 

 

 
Open Model 

Geometry – Solid – Assignment – Structural Steel 
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Mesh – Generate Mesh 
 

 

Harmonic Response – Analysis Settings 

Range Minimum – 1 Hz 

Range Maximum – 100 Hz 
 

Select Face – Face – Harmonic Response – Insert – Fixed Support 
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Select Edge – Edge – Harmonic Response – Insert – Force 

 

Components – Y Component – (- 100 N) 

-ve sign is for down ward direction 
 

 

Solution – Insert – Deformation – Total – Solve 
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Solution – Insert – Stress – Normal – Solve 
 

 

Solution – Insert – Stress – Equivalent – Solve 
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RESULT & CONCLUSIONS: 
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VIVA QUESTIONS: 

 Define Harmonic Analysis ? 

 What are differences between boundary value problem and initial value problem? 

 How do you define two-dimensional elements? 

 What is meant by plane stress analysis? 

 Write a displacement function equation for CST element? 
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EXPERIMENT - 14 

EXPLICIT ANALYSIS OF CAR WITH 100M/S 
 

AIM: 

To determine the deformation in case of crash of a car with bumper at 100m/s 
 

SOFTWARE:  ANSYS 

 

THEORY: 
Determine the total deformation in case of car moving with velocity of 100m/s 

 
 

PROCEDURE: 
Step1- Create Geometry 
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Trim Unwanted Geometry 

 
 

Click Sketch Mode to Create  wall 

 

Extrude The Geometry  
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Right Click On Model to Update The model by default Steel is 

 
 
Mesh 

 
 

Putting Boundary Condition 

Fixing The Faces of the Wall 
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Give Velocity in Z Direction 

 
 

 Total Deformation 

 Equivalent Stress 
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RESULT & CONCLUSIONS: 

  



Methodist College of Engineering & Technology 

Department of Mechanical Engineering 

BE VI SEMESTER COMPUTER AIDED ENGINEERING LAB MANUAL Page 114 

 

 

VIVA QUESTIONS: 

 Differentiate between implicit and explicit analysis ? 

 Define time step  ? 

 Differentiate between preprocessor vs postprocessor ? 

 Define Hourglass? 

 What are the different post processor available for explicit analysis in 

ANSYS? 
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